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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Upgrade
The following explains the upgrade to Executive Scorecard version 9.4.

Note: The upgrade path that is currently supported is:
9.31 => 9.40

If you require other upgrade path, contact HP Software Support Online web site
(http://www.hp.com/go/hpsoftwaresupport).

Important:Connecting the new 9.4 instance to the 9.31 instance will disable the existing 9.31
instance.

This section includes the following topics:

l "Upgrade to 9.4 in a Typical Environment" on the facing page

l "Upgrade to 9.4 in a Distributed Environment" on page 43

l "Additional Steps" on page 91

HP IT Executive Scorecard (9.40)Page 6 of 100

UpgradeGuide
Upgrade

http://www.hp.com/go/hpsoftwaresupport


Upgrade to 9.4 in a Typical Environment
To upgrade to version 9.4 when you had a typical (one server) configuration in 9.03, use the
following procedure:

1. "Prerequisites" below

2. "Backup and Restore All Databases" on page 10

3. "Install Version 9.4 on a New Server" on page 10

4. "Steps for use with Extended Content " on page 13

5. "Run the Post-Install Wizard" on page 15

6. "Upgrade Configuration" on page 29

Prerequisites
1. It is recommended to duplicate all the 9.31 schemas before starting the upgrade procedure in

order to have both 9.31 and 9.4 up and running after the upgrade. To duplicate a schema in
MSSQL, right-click the schema, select Tasks > Back Up. In the Back UpDatabase <file_
name> dialog box, enter the name of the back up file in theName field in theBackup Set area,
select where you want to save the duplicate in theDestination area, and click OK. Make sure
that the back up is successful.

2. Backups:

a. Make sure you have enough disk space to backup all the DataWarehouse databases.

b. Back up the Staging and Target databases using SQL Server 2008 Studio.

c. Back up the SAP® Business Objects database.

d. Back up the SAP BusinessObjects Data Services database for disaster recovery
purposes.

e. Back up the 9.31 version.txt file for disaster recovery purposes.

f. Back up the database Logins and that each user's status is enabled and not locked.

g. Back up the 9.31 <HPXS folder>\agora\DataWarehouse\ExternalSources folder before
starting the upgrade.

3. Make sure that theManagement and Result databases are located on the same server.

4. Moving to unicode:
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n Due to themove to unicode, it is recommended to backup theManagement and Result
databases (as explained in "Backup and Restore All Databases" on page 10 in the
Administrator Guide) before performing the upgrade.

n In addition, if you are working with large DB schemas, define the Transaction Log size to be
aminimum of 1GB. Themigration process automatically migrates the database objects
from the VARCHAR data type to NVARCHAR.

5. Running ETL streams. Currently running ETL streams will be aborted during the upgrade
procedure. You can cancel the upgrade, wait for the completion of the ETL streams execution,
and then start the upgrade.

6. Working with non-English languages:

If the language of one or more of the language packs that you are going to configure uses a non-
Latin character set, themanagement databasemust be created with the collation for the
relevant language.

7. Installation Settings: Ensure that you have the relevant installation settings required for the
installation. For details, see the IT Executive Scorecard Support Matrix.

8. It is recommended to install the 9.4 version on a new server in order to have both 9.31 and 9.4
up and running after the upgrade.

9. To restore theManagement, Result, Target, and Staging databases, right-click Database in
the relevant SQL server and select Restore Database. In the Restore Database dialog box,
select From device, and click the button. In the Specify Backup dialog box, click Add. Select
the duplicate file, and click OK.

10. Install the following on the typical server, before you start the component installation:

a. SQLCMD utility as follows:

i. On theMicrosoft SQL Server 2008 Enterprise Edition with SP 2CD, run Setup.

Note:

o If you did not previously install Microsoft .NET Framework 3.5.1 on your
server, youmay be prompted to install it. When installingMicrosoft .NET
Framework 3.5.1, make sure that WCF Activation is unchecked.

o When installing the SQLCMD utility, make sure that the path to the utility is
not enclosed in quotes (") and does not include quotes as this might cause the
installation of DataWarehouse to fail.

ii. Select New SQL Server Standalone Installation.

iii. On the Feature Select screen, selectManagement Tools - Basic, unselect
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Management Tools - Complete, and finish theWizard.

Note: If you want to use the default HTTP port in the Executive Scorecard
installation, ensure that port 80 is available after the installation of the SQLCMD
tool. For more information about the ports, see the Support Matrix document
available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the Installation DVD).

11. When usingM-iCP:

Configure the DataWarehouse server to avoid low virtual memory prompts when usingM-iCP
as follows:

a. Make sure that you have a hard disk capacity of at least 60G-80G.

b. Set the server virtual memory to system managed size.

c. Restart the server.

d. In Folder Options, clearHide protected operating system files.

e. Make sure that the pagefile.sys size is greater or equal to your physical memory size.

f. Make sure that you have enough free space on your system drive.

12. Email functionality inside the application. For the “send email” functionality to work, make
sure that the operating system and/or browser of the end user are configured to handlemailto:
links.

13. Browsers. It is recommended to close all browsers before starting the upgrade.

14. If you are using CAPs and an upgrade from one server to another server (upgrade side-by-
side):

a. Copy the <CAP_name>.ZIP files from: <installation
directory>\agora\glassfish\glassfish\domains\btoa\config\cap\import\load and
<installation
directory>\agora\glassfish\glassfish\domains\btoa\config\cap\import\loaded folders
located on the source server to the same folders on the target server.

b. If you work with localized CAP files, they should be copied at the same time.

15. If your upgrade to XS 9.31 was configured with LDAP, copy the external-ldap.properties file
from: <Installation Directory>\agora\glassfish\glassfish\domains\BTOA\config\conf in
the 9.31 environment to the same location in the just upgraded 9.4.

Note: For ITFM users: While all pages and KPIs are automatically transferred in the upgrade,
the upgrade does not include a transfer of ITFM allocations created in 9.31. In these cases,
contact HP support for instructions.
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Backup and Restore All Databases
The database upgrade process requires you to clone the current production database (on the same
machine) and to implement the upgrade process on the cloned restored database. Make sure the
databases you restore are up to date.

Before performing backup and restore make sure:

l The database server has enough disk space to contain both the backup files and the cloned
database.

l The directory structure and drives for the cloned database exist on the server.

l The source database names do not exist in the destination database. If the names do exist, they
will be overwritten.

To backup and restore the databases:

Note: DataWarehouse only supports Microsoft SQL Server 2008 R2, therefore the backup
and restore process is only supported for this version.

1. Backup the source Staging, Target, Management, and Results databases using SQL Server
2008 Studio. Make sure that the backup file names are unique and that they do not exist on the
destination database server.

2. Restore the backup of the source databases on the destination server using new names. make
a note of the restored names to be used during the upgrade.

Note: Youmust also backup the SAP BusinessObjects Data Services database for
disaster recovery purposes.

Install Version 9.4 on a New Server

Note: No data will be lost during the upgrade process. All data that is created during the
upgrade process will be retrieved upon completion directly from the data sources.

1. Ensure that you have the relevant installation settings required for the installation as described
in the "Installation Checklists".

2. Close all Windows before you start the installation process.

3. Insert the XS media into the CD/DVD drive. The installation wizard opens.

HP IT Executive Scorecard (9.40)Page 10 of 100

UpgradeGuide
Upgrade to 9.4 in a Typical Environment



Caution: The CD/DVD must remain in the drive until you complete the Executive
Scorecard ConfigurationWizard.

Note: If the installation wizard does not start automatically, run the file: <DVD_
ROOT>\Windows_Setup\HPXS_9.4_setup.exe

 If you copy the installation directory from the DVD or from HPLN, make sure that the
path to the target directory does not include blank spaces.

4. Installation Section of Wizard

Follow the prompts until you get to theSelect Group page.

5. On theSelect Group page, select the type of installation you are performing: Single Server
installation, and then click Next.

6. On theSelect Features page, Common Components are automatically selected and
installed with each component.

7. On theChoose the folders page, click Next to accept the default application folder, or
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Browse to navigate to and then select a new application folder location.

Note: If you enter a new application folder name, it cannot contain embedded spaces. For
example a folder with a nameHP XS is invalid.

The wizard then runs a series of checks to validate system requirements.

If an installation check failed, youmight be required to perform corrective action before you can
run the installer. Certain checks can be corrected after a component has been installed.

8. On the Install Checks page, ensure that all the installation checks are successful, and then
click Next.

9. On thePre-Install Summary page, verify that the components you wish to install are listed,
and then click Install. The Post-Install wizard window opens.
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10. Copy the external sources folder : <install drive>\<Installation
directory>\agora\DataWarehouse\ExternalSources to the new installationmachine under:
<install drive>\<Installation diectory>\agora\ DataWarehouse\.

The file copying process starts. On completion, the Post-Install Wizard opens.

Note: If the server is not compliant with certain minimum system requirements such as
free disk space, the install process does not begin.

Steps for use with Extended Content
If you have extensions to out-of-the-box content packs:

Note: Make sure that every change that was done in the BODS workflows is synchronized
with the content packs xml files. For information see the HP Software Support web site, or
contact your HP Support representative.

Copy the following folders:

l <install drive>\<Installation directory>\agora\ContentPacks\<cp
name>\dataModel\dataIntegration\extraction\_CUSTOMIZATION

to the new installationmachine under:

<install drive>\<Installation directory>\agora\ContentPacks\<cp
name>\dataModel\dataIntegration\extraction\_
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l <install drive>\<Installation directory>\agora\ContentPacks\<cp
name>\dataModel\dataIntegration\source\_CUSTOMIZATION

to the new installationmachine under:

<install drive>\<Installation directory>\agora\ContentPacks\<cp
name>\dataModel\dataIntegration\source\

l <install drive>\<Installation directory>\agora\ContentPacks\<cp name>\ETL\entities\_
CUSTOMIZATION

to the new installationmachine under:

<install drive>\<Installation directory>\agora\ContentPacks\<cp name>\ETL\entities\

If you created new content packs:

Note: Make sure that every change that was done in the BODS workflows is synchronized
with the content packs xml files. For information see the HP Software Support web site, or
contact your HP Support representative.

Copy the content pack folder from:

<install drive>\<Installation directory>\agora\ContentPacks\<cp name>\

to the new installationmachine under:

<install drive>\<Installation directory>\agora\ContentPacks\

If you have extensions to the FBI extractor:

1. Back up the 9.4 fbi-web.war from the folder: <install drive>\<Installation
directory>\agora\apps.

2. Open the file usingWin RAR.

3. Copy the extension JAR to theWEB-INF\lib\ directory in the war file.

4. Overwrite the fbi-web.war file to <install drive>\<Installation directory>\agora\appswith
the updated war file.

5. Open the fbi-web.war file to make sure that the new JAR is placed under the right path.

6. Resume the post install.
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Run the Post-Install Wizard
1. On the Introduction page of the ConfigurationWizard, click Next.

Note: Make sure that in the following steps, you enter the details about the restored
databases.

2. Configure the Management Database:

a. In theManagement Database - Configure Management Settings page, select Connect
to an existing database and click Next.
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UI Element Description

Create a new
database

Select this option to create a new Management database.

Connect to an
existing
database

This option connects to an existingManagement database.

Select this option when theManagement database has already been
created while installing a previous component or when performing an
upgrade.

b. On theManagement Database - Configure Management Database Connectivity
Settings page, enter the following, and then click Next.
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UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting theManagement database.

Note:

If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.

Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change this
value to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available
from the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or
from the Installation DVD).

Note:

If you work with the Named Instance feature, you can omit the port number (it
is automatically detected during the installation).

Database
name

The name of theManagement database.

It is recommended that you use the following database naming convention:
databasename_mng_

Tip: The database namemust be the name of the restored database.

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database. The user
must have the administrator permissions.

Password The password for the specified user.

Note:

o The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

o The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

o The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

c. On theManagement Database Configuration Status page, verify that theManagement
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database configuration was completed successfully, and then click Next.

d. In theManagement Database - Load a License page, check that a valid permanent
license was found, and click Next.

The wizard recognizes the license entered in the previous version.

Configure SAP BusinessObjects Enterprise
1. In theSAP BusinessObjects Enterprise for HP XS - Installation Directory page, enter the

path to the installation directory in the Installation Directory field, and click Next.

2. In theSAP BusinessObjects Enterprise for HP XS - Configure Server Connectivity
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page, enter the relevant information, and click Next.

UI Element
(A-Z) Description

Installation
directory

The directory where SAP BusinessObjects Enterprise will be installed.

Click Next to install SAP BusinessObjects Enterprise in the default
installation directory.

To select an alternate installation directory, click Browse, navigate to the
required installation directory, select it, and proceed with the installation.

3. On the SAP BusinessObjects Enterprise for HP XS - Configure Server Connectivity
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page, enter the following, and then click Next.

UI Element Description

CMS port The port number of the CMS listener. The default value is 6400. For more
information about ports, see the Support Matrix document available from the
Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).
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UI Element Description

Administrator
password

The SAP BusinessObjects Enterprise Administrator password. This
password is used only to login to SAP BusinessObjects Enterprise.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

Confirm
administrator
password

Confirm the Administrator password.

Tomcat port The port number of the Tomcat listener. The default value is 8080. For more
information about ports, see the Support Matrix document available from the
Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

4. In theSAP BusinessObjects Enterprise for HP XS - Configure Central Management
Server (CMS) Database page, select Create a new CMS database, and click Next.

5. On theSAP BusinessObjects Enterprise for HP XS - Configure Central Management
Server (CMS) Database Connectivity Settings page, if required, enter the following, and
then click Next.
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UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQL 2008 Server
hosting the CMS database.

Note:

If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.
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UI
Element Description

Port The port of theMS SQL server listener. The default port is 1433. For more
information about ports, see the Support Matrix document available from the
Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).

Database
name

The name of the CMS database.

It is recommended that you use the following database naming convention:

databasename_cms

SQL Server authentication area:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database. The user must
have the administrator permissions.

Password The password for the specified user.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

6. In theSAP BusinessObjects Enterprise for HP XS - CMS Database Configuration
Status page, make sure that the operation completed successfully, and click Next.

7. On the SAP BusinessObjects Enterprise for HP XS -Configure Audit Database page,
select Install Audit schema in the CMS database, and then click Next.
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UI Element Description

Install Audit schema in the
CMS database

Installs the Audit database schema as part of the CMS
database previously created.

Create a new Audit database Creates a new Audit database.
Connect to an existing Audit
database

Connect to an existing Audit database.

8. In theSAP BusinessObjects Enterprise for HP XS - Audit Database Configuration
Status page, make sure that the operation completed successfully, and click Next.

9. In theSAP BusinessObjects Enterprise for HP XS - Configuration Status page, make
sure that the operation completed successfully, and click Next.
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10. On theApplication Configuration - Configure Web Server Infrastructure Connectivity
page, enter the following, and then click Next.

Data related configuration area:

UI
Element Description

Time Zone The DataWarehouse time zone used when consolidating the data extracted from
the data sources.

Web Server Configuration area:
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UI
Element Description

HTTP
port

The port of the HTTP listener. The default port is 80. For more information about
ports, see the Support Matrix document available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the Installation DVD).

Note: If you want to use the default HTTP port in the Executive Scorecard
installation, youmust ensure that port 80 is not in use by another process.

HTTPS
port

The port of the HTTPS listener. The default port is 443. For more information about
ports, see the Support Matrix document available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the Installation DVD).

Business Objects enterprise area:

UI Element Description

SSO shared secret Enter the SSO shared secret.

Confirm SSO shared secret Confirmation of the SSO shared secret.

11. On theApplication Configuration - Configure Infrastructure Connectivity page, enter the
following, and then click Next.
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UI Element Description

Administrator
user name

The user name for the administrator.

Use this user to log into Executive Scorecard for the first time.
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UI Element Description

Administrator
password

The password for the administrator.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain
a combination of two of the following; upper case, lower case, numbers
and punctuation.

n The password can be changed by the Administrator. In such a case,
the relevant password setting should be changed accordingly.

Confirm
Administrator
password

Confirmation of the administrator password.
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Upgrade Configuration
1. In theManagement Database - Upgrade required page, click Next to perform the upgrade.

2. In theManagement Database - Configure Result Database Connectivity Settings for the
Upgrade page, enter the relevant information and enter in the Database Name field the name
of the restored 9.31 Result/DATA Schema, and click Next.
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UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting the Result database.

Note:

If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.
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UI
Element Description

Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change this value
to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available from
the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).

Database
name

The name of the Result database that was restored earlier.

It is recommended that you use the following database naming convention:
databasename_res_upg

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database. The user must
have the administrator permissions.

Password The password for the specified user.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

3. In theManagement Database - Configure Target Database Connectivity Settings for the
Upgrade page, enter the relevant information and enter in the Database Name field the name
of the restored 9.31 Target Schema, and click Next.
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Enter connectivity and authentication parameters for the Target MS SQL Server
database:

UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting the Target database.

Note:

If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.
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UI
Element Description

Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change this value
to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available from
the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).

Database
name

The name of the Target database that was restored earlier.

It is recommended that you use the following database naming convention:
databasename_trg_upg

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database. The user must
have the administrator permissions.

Password The password for the specified user.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

7. In theManagement Database - Configure Staging Database Connectivity Settings for
the Upgrade page,enter the relevant information and enter in the Database Name field the
name of the duplicated 9.03 Staging Schema, and click Next.
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Enter connectivity and authentication parameters for the Staging MS SQL Server
database:

UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting the Staging database.

Note:

If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.
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UI
Element Description

Port The port of theMS SQL server listener. The default port is 1433. Change this
value to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available
from the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from
the Installation DVD).

Note:

If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).

Database
name

The name of the Staging database that was restored earlier.

It is recommended that you use the following database naming convention:
databasename_stg_upg

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database. The user
must have the administrator permissions.

Password The password for the specified user.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

4. In theManagement Database - Upgrade Summary page, check that the upgrade was
completed successfully, and click Next.
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5. In theData Warehouse - SAP BusinessObjects Data Services for HP XS page, enter the
relevant information, and click Next.
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UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting the SAP BusinessObjects Data Services database.

n Do not use localhost as the host name.

n The sum of the number of characters of the following names must not exceed
65:
o The Host name FQDN

o The SAP BusinessObjects Data Services database name

o The number of the server port.

o The Login Name.

Note:

If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.

Port The port of theMS SQL server listener. The default port is 1433. For more
information about ports, see the Support Matrix document available from the
Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).

Database
name

The name of the SAP BusinessObjects Data Services database.

It is recommended that you use the following database naming convention:

databasename_bods

SQL Server authentication area:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database. The user
must have the administrator permissions.

HP IT Executive Scorecard (9.40)Page 38 of 100

UpgradeGuide
Upgrade to 9.4 in a Typical Environment

http://h20230.www2.hp.com/selfsolve/manuals


UI
Element Description

Password The password of the specified login.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

Database login authentication area:

UI Element Description

New Login
name

A new MS SQL login created for the SAP BusinessObjects Data Services
database.

A SAP BusinessObjects Data Services database user account with the
same name is automatically created.

Note:

n The Login Name can only comprise alphanumeric characters and if
required an underscore.

n Do not use XS as a new database login name because the XS user name
is already used internally.

Password The password for the new login.

The same password is also applied to the database user account.

Note:

n The password can comprise alphanumeric characters and an underscore.

n It is important that you save the password in a safe place as it may be
required in certain disaster recovery scenarios.

Confirm
Password

Confirmation of the password for the new login.

Installation directory area:
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UI Element Description

Installation
directory

The location where you want to install SAP BusinessObjects Data Services.

Themaximum allowable path length is 69 characters. In addition, the
Installation directory field does not support multi-byte characters. To install
the software on a system with amulti-byte locale, youmust specify the
installation directory with single-byte characters or use the default location.

To run the Designer, a user requires both read and write access to the
installation directory.

6. In theData Warehouse - Configure External Source & External Source Archive File
Location page, enter the relevant information, and click Next.
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Specify the external source archiving folder:

UI Element Description

Enable external
source archiving
folder

Select to start archiving external data source data files.

Location Specify where you want to archive the external data source data files.

Note: Because archiving data files can bememory intensive, it
is recommended to archive to a dedicated separate logical drive.
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7. In theData Warehouse - Configuration Status page, make sure that the operation
completed successfully, and click Next.

8. In theExecutive Scorecard - Executive Scorecard Summary page, make sure that the
operation completed successfully, and click Next.

9. In the Financial Planning and Analysis - Installing FPA page, click Next.

10. In the Financial Planning and Analysis - Summary page, make sure that the operation
completed successfully, and click Next.

11. In theSummary page, make sure that the operation completed successfully, and click Finish.

12. If after the upgrade the followingmessage is displayed when you try to open the application:
The application is out-of-date. Click the Refresh button on your browser, clean the
temporary Internet files and reopen the application.

Note:

n The upgrade changed the name and configuration of some of the KPIs, in addition to
adding new KPIs. Each out-of-the-box KPIs has its own and unique UUID, so after the
upgrade, the renamed ormodified KPIs appear In the KPI Library (KPIs templates area)
overriding the previous KPIs (according to the UUID). A KPI that was already activated
in the previous version (dragged to the Active KPIs area) is not overridden during the
upgrade. If you drag one of the upgraded KPIs from the KPI Library to the Active KPIs
area, the new setting is displayed. The active KPI from the previous version and the
active KPI from 9.31 have different UUIDs but have the same template UUID.

n At the end of the upgrade, verify the log files. If errors are found in the log files,
investigate, correct, and consider re-running the upgrade process. For details on the log
files, see Logs in theAdministrator Guide.

13. You can now proceed with "Additional Steps" on page 91.
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Upgrade to 9.4 in a Distributed
Environment

To upgrade to version 9.4 when you had a distributed configuration in 9.31, use the following
procedure:

1. "Prerequisites" below

2. "Upgrade to 9.4 in a Distributed Environment" above

3. "Install BusinessObjects Enterprise" on page 46

4. "Install DataWarehouse on a Separate Server" on page 49

5. "Install Executive Scorecard on a Separate Server" on page 75

Prerequisites
1. It is recommended to duplicate all the 9.31 schemas before starting the upgrade procedure in

order to have both 9.31 and 9.4 up and running after the upgrade. To duplicate a schema in
MSSQL, right-click the schema, select Tasks > Back Up. In the Back UpDatabase <file_
name> dialog box, enter the name of the back up file in theName field in theBackup Set area,
select where you want to save the duplicate in theDestination area, and click OK. Make sure
that the back up is successful.

2. Backups:

a. Make sure you have enough disk space to backup all the DataWarehouse databases.

b. Back up the Staging and Target databases using SQL Server 2008 Studio.

c. Back up the SAP® Business Objects database.

d. Back up the SAP BusinessObjects Data Services database for disaster recovery
purposes.

e. Back up the 9.31 version.txt file for disaster recovery purposes.

f. Back up the database Logins and that each user's status is enabled and not locked.

g. Back up the 9.31 <HPXS folder>\agora\DataWarehouse\ExternalSources folder before
starting the upgrade.

3. Make sure that theManagement and Result databases are located on the same server.

4. Moving to unicode:
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n Due to themove to unicode, it is recommended to backup theManagement and Result
databases (as explained in "Upgrade to 9.4 in a Distributed Environment" on the previous
page in theAdministrator Guide) before performing the upgrade.

n In addition, if you are working with large DB schemas, define the Transaction Log size to be
aminimum of 1GB. Themigration process automatically migrates the database objects
from the VARCHAR data type to NVARCHAR.

5. Running ETL streams. Currently running ETL streams will be aborted during the upgrade
procedure. You can cancel the upgrade, wait for the completion of the ETL streams execution,
and then start the upgrade.

6. Working with non-English languages:

If the language of one or more of the language packs that you are going to configure uses a non-
Latin character set, themanagement databasemust be created with the collation for the
relevant language.

7. Installation Settings: Ensure that you have the relevant installation settings required for the
installation. For details, see the IT Executive Scorecard Support Matrix.

8. It is recommended to install the 9.4 version on a new server in order to have both 9.31 and 9.4
up and running after the upgrade.

9. Restore theManagement, Result, Target, and Staging databases, right-click Database in the
relevant SQL server and select Restore Database. In the Restore Database dialog box, select
From device, and click the button. In the Specify Backup dialog box, click Add. Select the
duplicate file, and click OK.

10. Install the following on the DataWarehouse server, before you start the component
installation:

a. SQLCMD utility as follows:

i. On theMicrosoft SQL Server 2008 Enterprise Edition with SP 2CD, run Setup.

Note:

o If you did not previously install Microsoft .NET Framework 3.5.1 on your
server, youmay be prompted to install it. When installingMicrosoft .NET
Framework 3.5.1, make sure that WCF Activation is unchecked.

o When installing the SQLCMD utility, make sure that the path to the utility is
not enclosed in quotes (") and does not include quotes as this might cause the
installation of DataWarehouse to fail.

ii. Select New SQL Server Standalone Installation.
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iii. On the Feature Select screen, selectManagement Tools - Basic, unselect
Management Tools - Complete, and finish theWizard.

Note: If you want to use the default HTTP port in the Executive Scorecard
installation, ensure that port 80 is available after the installation of the SQLCMD
tool. For more information about the ports, see the Support Matrix document
available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the Installation DVD).

11. When usingM-iCP:

Configure the DataWarehouse server to avoid low virtual memory prompts when usingM-iCP
as follows:

a. Make sure that you have a hard disk capacity of at least 60G-80G.

b. Set the server virtual memory to system managed size.

c. Restart the server.

d. In Folder Options, clearHide protected operating system files.

e. Make sure that the pagefile.sys size is greater or equal to your physical memory size.

f. Make sure that you have enough free space on your system drive.

12. Email functionality inside the application. For the “send email” functionality to work, make
sure that the operating system and/or browser of the end user are configured to handlemailto:
links.

13. Browsers. It is recommended to close all browsers before starting the upgrade.

14. If you are using CAPs and an upgrade from one server to another server (upgrade side-by-
side):

a. Copy the <CAP_name>.ZIP files from: <installation
directory>\agora\glassfish\glassfish\domains\btoa\config\cap\import\load and
<installation
directory>\agora\glassfish\glassfish\domains\btoa\config\cap\import\loaded folders
located on the source server to the same folders on the target server.

b. If you work with localized CAP files, they should be copied at the same time.

15. If your upgrade to XS 9.31 was configured with LDAP, copy the external-ldap.properties file
from: <Installation Directory>\agora\glassfish\glassfish\domains\BTOA\config\conf in
the 9.31 environment to the same location in the just upgraded 9.4.
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Backup and Restore All Databases
The database upgrade process requires you to clone the current production database (on the same
machine) and to implement the upgrade process on the cloned restored database. Make sure the
databases you restore are up to date.

Before performing backup and restore make sure:

l The database server has enough disk space to contain both the backup files and the cloned
database.

l The directory structure and drives for the cloned database exist on the server.

l The source database names do not exist in the destination database. If the names do exist, they
will be overwritten.

To backup and restore the databases:

Note: DataWarehouse only supports Microsoft SQL Server 2008 R2, therefore the backup
and restore process is only supported for this version.

1. Backup the source Staging, Target, Management, and Results databases using SQL Server
2008 Studio. Make sure that the backup file names are unique and that they do not exist on the
destination database server.

2. Restore the backup of the source databases on the destination server using new names. make
a note of the restored names to be used during the upgrade.

Note: Youmust also backup the SAP BusinessObjects Data Services database for
disaster recovery purposes.

Install BusinessObjects Enterprise
SAP BusinessObjects Enterprisemust be the first component you install.

Note: Virus scanning softwaremay interfere with the installation of SAP BusinessObjects
Enterprise. Turn off all virus scanning software before installing.

1. Create a Schema in the DB server.

2. In the DB server, if you use a 64 bit operating system, run the command:
C:\Windows\SysWOW64\odbcad32.exe and do not use the option: go to Control Panel >
Administrative Tools > Data Sources (ODBC). You can use this option on 64 bit OS.
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3. In theODBC Data Source Administrator, click theSystem DNS tab, and theAdd button to
add related Data Source:

4. In theCreate New Data Source page that opens, select the SQL Server driver and click
Finish.

5. In theCreate a New Data Source to SQL Server page, enter the information to create the
ODBC data source for your BOE database, and click Next.

6. In the next Create a New Data Source to SQL Server page, select the With SQL Server
authentication using a login ID and password entered by the user, select theConnect
to SQL Server to obtain default settings for the additional configuration options and
enter the Login ID andPassword, Use ANSI quoted identifiers and Use ANSI nulls,
paddings and warnings. Click Next.

7. In the next Create a New Data Source to SQL Server page, select the Schema you created
before and select theChange the default database to option, and select the schema you
created previously. Click Next.

8. In theMicrosoft SQL Server DSN Configuration page, select Perform translation for
character data, and click Finish.

9. In theODBC Microsoft SQL Server Setup page click Test Data Source, and wait for the
message TESTS COMPLETED SUCCESSFULLY!

Install BusinessObjects Enterprise:

1. Close all Windows before you start the installation process.

2. Insert the XS media into the CD/DVD drive. The installation wizard opens.

Caution: The CD/DVD must remain in the drive until you complete the Executive
Scorecard ConfigurationWizard.

Note: If the installation wizard does not start automatically, run the file: <DVD_
ROOT>\Windows_Setup\packages\boe_installer\setup.exe 

 If you copy the installation directory from the DVD or from HPLN, make sure that the
path to the target directory does not include blank spaces.

3. In theBusinessObjects Enterprise XI 3.1 Setup - User Information page, insert the
license key in theProduct Keycode field. Click Next.

4. In theBusinessObjects Enterprise XI 3.1 Setup - Install Type page, select New, Use an
existing database server, andEnable servers upon installation. Click Next.
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5. In theBusinessObjects Enterprise XI 3.1 Setup - Server Components Configuration
page, enter 6400 in theCMS port field and select Configure the BusinessObjects
Enterprise Administrator at a later time. Click Next.

6. In theBusinessObjects Enterprise XI 3.1 Setup - Server Intelligence Agent page, enter
the name of the node in theNode Name field, and the port number (6410) in thePort field.
Click Next.

7. In theBusinessObjects Enterprise XI 3.1 Setup - CMS Database Information page, select
SQL Server (ODBC) in theCMS Database area in theSelect existing CMS database
dropdown.

8. Click Browse to select the relevant data source in theData Source Name field and enter the
password in thePassword field, in the SQL Server Logon dialog box. Click OK.

9. In theBusinessObjects Enterprise XI 3.1 Setup page - Select Web Application Server,
select Java Web Application Server and Install Tomcat application server and deploy to
it. Click Next.

10. Click Next using all the default ports.

Note: TheBOWInstall_0.log Installation log file is saved in the temp folder.

11. To login to BusinessObjects Enterprise after installation, use the following URL:

http://<server name>:8080/CmcApp

User: administrator, Password: (empty).

12. In theBusinessObjects Enterprise XI 3.1 Setup - Automatically Re-Deploy Web
Applications? page, select Yes, automatically re-deploy the web applications. Click
Next.

13. As you have already installed Tomcat, in theBusinessObjects Enterprise XI 3.1 Setup -
Configure Web Application Server page, enter the server instance in theServer Instance
field, the service name in theService Name field, and the path to the Tomcat in the Application
Server Installation Directory field. Click Next to install.

Configure the JDBC driver:

1. Copy the sqljdbc.jar into <BOE install folder>\common\4.0\java\lib\external directory.

2. In the <BOE install folder>\BusinessObjects Enterprise 12.0\win32_
x86\dataAccess\connectionServer\jdbc\jdbc.sbo file add the following lines to the
<JDBCDriver> section of MS SQLServer 2005 configuration:

<ClassPath>
<Path>C:\Program Files (x86)\Business
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Objects\common\4.0\java\lib\external\sqljdbc.jar</Path>
</ClassPath>

3. In the <BOE install folder>\common\4.0\java\CRConfig.xml file, add the following in the
<Classpath> section of <DataDriverCommon>:

<BOE install folder>\common\4.0\java\lib\external\sqljdbc.jar;

Install Data Warehouse on a Separate Server

Note: No data will be lost during the upgrade process. All data that is created during the
upgrade process will be retrieved upon completion directly from the data sources.

1. Ensure that you have the relevant installation settings required for the installation as described
in the "Installation Checklists".

2. Close all Windows before you start the installation process.

3. Insert the XS media into the CD/DVD drive. The installation wizard opens.

Caution: The CD/DVD must remain in the drive until you complete the Executive
Scorecard ConfigurationWizard.

Note: If the installation wizard does not start automatically, run the file: <DVD_
ROOT>\Windows_Setup\HPXS_9.30_setup.exe

 If you copy the installation directory from the DVD or from HPLN, make sure that the
path to the target directory does not include blank spaces.

4. Installation Section of Wizard

Follow the prompts until you get to theSelect Group page.

5. On theSelect Group page, select the type of installation you are performing: Distributed
Installation, and then click Next.
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6. If necessary, on theSelect Features page, select the component you are installing on this
server, and then click Next.

Common Components are automatically selected and installed with each component.

7. On theChoose the folders page, click Next to accept the default application folder, or
Browse to navigate to and then select a new application folder location.

Note: If you enter a new application folder name, it cannot contain embedded spaces. For
example a folder with a nameHP XS is invalid.

The wizard then runs a series of checks to validate system requirements. If an installation
check failed, youmight be required to perform corrective action before you can run the installer.
Certain checks can be corrected after a component has been installed.

8. On the Install Checks page, ensure that all the installation checks are successful, and then
click Next.
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9. On thePre-Install Summary page, verify that the components you wish to install are listed,
and then click Install. The Post-Install wizard window opens.

10. Copy the external sources folder : <install drive>\<Installation
directory>\agora\DataWarehouse\ExternalSources to the new installationmachine under:
<install drive>\<Installation diectory>\agora\ DataWarehouse\.
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The file copying process starts. On completion, the Post-Install Wizard opens.

Note: If the server is not compliant with certain minimum system requirements such as
free disk space, the install process does not begin.

Steps for use with Extended Content
If you have extensions to out-of-the-box content packs:

Note: Make sure that every change that was done in the BODS workflows is synchronized
with the content packs xml files. For information see the HP Software Support web site, or
contact your HP Support representative.

Copy the following folders:

l <install drive>\<Installation directory>\agora\ContentPacks\<cp
name>\dataModel\dataIntegration\extraction\_CUSTOMIZATION

to the new installationmachine under:

<install drive>\<Installation directory>\agora\ContentPacks\<cp
name>\dataModel\dataIntegration\extraction\_

l <install drive>\<Installation directory>\agora\ContentPacks\<cp
name>\dataModel\dataIntegration\source\_CUSTOMIZATION

to the new installationmachine under:

<install drive>\<Installation directory>\agora\ContentPacks\<cp
name>\dataModel\dataIntegration\source\

l <install drive>\<Installation directory>\agora\ContentPacks\<cp name>\ETL\entities\_
CUSTOMIZATION

to the new installationmachine under:

<install drive>\<Installation directory>\agora\ContentPacks\<cp name>\ETL\entities\

If you created new content packs:

Note: Make sure that every change that was done in the BODS workflows is synchronized
with the content packs xml files. For information see the HP Software Support web site, or
contact your HP Support representative.

Copy the content pack folder from:

<install drive>\<Installation directory>\agora\ContentPacks\<cp name>\
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To the new installationmachine under:

<install drive>\<Installation directory>\agora\ContentPacks\

If you have extensions to the FBI extractor:

1. Back up the 9.4 fbi-web.war from the folder: <install drive>\<Installation
directory>\agora\apps.

2. Open the file usingWin RAR.

3. Copy the extension JAR to theWEB-INF\lib\ directory in the war file.

4. Overwrite the fbi-web.war file to <install drive>\<Installation directory>\agora\appswith
the updated war file.

5. Open the fbi-web.war file to make sure that the new JAR is placed under the right path.

6. Resume the post install.

Post-Install Wizard - Management Database Section

1. On the Introduction page, click Next.

2. On theManagement Database - Configure Management Database Settings page, select
Connect to existing, and then click Next.

3. On theManagement Database - Configure Management Database Connectivity Settings
page, enter the information and then click Next.
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UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting theManagement database.

Note:

If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.
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UI
Element Description

Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change this value
to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available from
the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).

Database
name

The name of theManagement database.

It is recommended that you use the following database naming convention:
databasename_mng

Tip: Make note of the database name, as it may be needed when installing other
components.

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database. The user must
have the administrator permissions.

Password The password for the specified user.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

4. On theManagement Database - Management Configuration Status page, verify that the
operation completed successfully. and then click Next.

5. In theManagement Database - Load a License page, check that a valid permanent license
was found, and click Next.
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6. The wizard recognizes the license entered in the previous version.

7. On theApplication Configuration - Configure Web Server Infrastructure Connectivity
page, enter the information and then click Next.
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Data related configuration area:

UI
Element Description

Time Zone The DataWarehouse time zone used when consolidating the data extracted from
the data sources.

Web Server Configuration area:

UI
Element Description

HTTP
port

The port of the HTTP listener. The default port is 80. For more information about
ports, see the Support Matrix document available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the Installation DVD).

Note: If you want to use the default HTTP port in the Executive Scorecard
installation, youmust ensure that port 80 is not in use by another process.

HTTPS
port

The port of the HTTPS listener. The default port is 443. For more information about
ports, see the Support Matrix document available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the Installation DVD).

8. On theApplication Configuration - Configure Infrastructure Connectivity page, enter the
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information and then click Next.

UI Element Description

Administrator
user name

The user name for the administrator.

Use this user to log into Executive Scorecard for the first time.

HP IT Executive Scorecard (9.40)Page 58 of 100

UpgradeGuide
Upgrade to 9.4 in a Distributed Environment



UI Element Description

Administrator
password

The password for the administrator.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain
a combination of two of the following; upper case, lower case, numbers
and punctuation.

n The password can be changed by the Administrator. In such a case,
the relevant password setting should be changed accordingly.

Confirm
Administrator
password

Confirmation of the administrator password.

9. On theApplication Configuration - Configure Infrastructure Connectivity page, enter the
information and then click Next.
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UI Element Description

Host name The fully qualified domain name (FQDN) or IP address of the SAP
BusinessObjects Enterprise XI 3.1 server.

CMS Port The port number used by the CMS listener. The default value when SAP
BusinessObjects Enterprise is installed as part of the Executive Scorecard
installation, is 6400.

Administrator
User name

The SAP BusinessObjects Enterprise XI 3.1 administrator user name.

Note: This user name and the following password are used when logging in
to the SAP BusinessObjects Enterprise applications.

Administrator
password

The SAP BusinessObjects Enterprise XI 3.1 administrator password.
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UI Element Description

Confirm
Administrator
password

Confirmation of the administrator password.

SSO shared
secret

The shared secret that is used to authenticate communications with the SAP
BusinessObjects Enterprise XI 3.1 server. If trusted authentication is
configured, the shared secret entered is validated against the SAP
BusinessObjects Enterprise XI 3.1 server. If trusted authentication is not
configured, the entered shared secret is configured on the SAP
BusinessObjects Enterprise XI 3.1 server.

Confirm SSO
shared secret

Confirmation of the SSO shared secret.

Authentication
scheme

Select one of the following SAP BusinessObjects Enterprise XI 3.1
authentication schemes that contains the administrator account:

n secEnterprise - When the SAP BusinessObjects administrator account
is a native Enterprise account.

n secLDAP - When the SAP BusinessObjects administrator account
originates from an LDAP user database.

Tomcat Port The port used by the Tomcat listener. The default value is 8080. For more
information about ports, see the Support Matrix document available from the
Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Upgrade Configuration for DWH
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1. In theManagement Database - Upgrade required page, click Next to perform the upgrade.

2. In theManagement Database - Configure Result Database Connectivity Settings for the
Upgrade page, enter the relevant information and enter in the Database Name field the name
of the restored 9.31 Result/DATA Schema, and click Next.
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UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting the Result database.

Note:

If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.
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UI
Element Description

Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change this value
to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available from
the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).

Database
name

The name of the Result database that was restored earlier.

It is recommended that you use the following database naming convention:
databasename_res_upg

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database. The user must
have the administrator permissions.

Password The password for the specified user.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

3. In theManagement Database - Configure Target Database Connectivity Settings for the
Upgrade page, enter the relevant information and enter in the Database Name field the name
of the restored 9.31 Target Schema, and click Next.
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Enter connectivity and authentication parameters for the Target MS SQL Server
database:

UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting the Target database.

Note:

If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.
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UI
Element Description

Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change this value
to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available from
the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).

Database
name

The name of the Target database that was restored earlier.

It is recommended that you use the following database naming convention:
databasename_trg_upg

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database. The user must
have the administrator permissions.

Password The password for the specified user.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

7. In theManagement Database - Configure Staging Database Connectivity Settings for
the Upgrade page,enter the relevant information and enter in the Database Name field the
name of the duplicated 9.03 Staging Schema, and click Next.

HP IT Executive Scorecard (9.40)Page 66 of 100

UpgradeGuide
Upgrade to 9.4 in a Distributed Environment

http://h20230.www2.hp.com/selfsolve/manuals


Enter connectivity and authentication parameters for the Staging MS SQL Server
database:

UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting the Staging database.

Note:

If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.
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UI
Element Description

Port The port of theMS SQL server listener. The default port is 1433. Change this
value to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available
from the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from
the Installation DVD).

Note:

If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).

Database
name

The name of the Staging database that was restored earlier.

It is recommended that you use the following database naming convention:
databasename_stg_upg

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database. The user
must have the administrator permissions.

Password The password for the specified user.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

4. In theManagement Database - Upgrade Summary page, check that the upgrade was
completed successfully, and click Next.
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5. In theData Warehouse - SAP BusinessObjects Data Services for HP XS page, enter the
relevant information, and click Next.
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UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting the SAP BusinessObjects Data Services database.

n Do not use localhost as the host name.

n The sum of the number of characters of the following names must not exceed
65:
o The Host name FQDN

o The SAP BusinessObjects Data Services database name

o The number of the server port.

o The Login Name.

Note:

If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.

Port The port of theMS SQL server listener. The default port is 1433. For more
information about ports, see the Support Matrix document available from the
Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).

Database
name

The name of the SAP BusinessObjects Data Services database.

It is recommended that you use the following database naming convention:

databasename_bods

SQL Server authentication area:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database. The user
must have the administrator permissions.
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UI
Element Description

Password The password of the specified login.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

Database login authentication area:

UI Element Description

New Login
name

A new MS SQL login created for the SAP BusinessObjects Data Services
database.

A SAP BusinessObjects Data Services database user account with the
same name is automatically created.

Note:

n The Login Name can only comprise alphanumeric characters and if
required an underscore.

n Do not use XS as a new database login name because the XS user name
is already used internally.

Password The password for the new login.

The same password is also applied to the database user account.

Note:

n The password can comprise alphanumeric characters and an underscore.

n It is important that you save the password in a safe place as it may be
required in certain disaster recovery scenarios.

Confirm
Password

Confirmation of the password for the new login.

Installation directory area:
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UI Element Description

Installation
directory

The location where you want to install SAP BusinessObjects Data Services.

Themaximum allowable path length is 69 characters. In addition, the
Installation directory field does not support multi-byte characters. To install
the software on a system with amulti-byte locale, youmust specify the
installation directory with single-byte characters or use the default location.

To run the Designer, a user requires both read and write access to the
installation directory.

6. In theData Warehouse - Configure External Source & External Source Archive File
Location page, enter the relevant information, and click Next.
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Specify the external source archiving folder:

UI Element Description

Enable external
source archiving
folder

Select to start archiving external data source data files.

Location Specify where you want to archive the external data source data files.

Note: Because archiving data files can bememory intensive, it
is recommended to archive to a dedicated separate logical drive.

7. In theData Warehouse - Configuration Status page, make sure that the operation
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completed successfully, and click Next.

Install Executive Scorecard on a Separate
Server

Note: No data will be lost during the upgrade process. All data that is created during the
upgrade process will be retrieved upon completion directly from the data sources.

1. Ensure that you have the relevant installation settings required for the installation as described
in the "Installation Checklists".

2. Close all Windows before you start the installation process.

3. Insert the XS media into the CD/DVD drive. The installation wizard opens.

Caution: The CD/DVD must remain in the drive until you complete the Executive
Scorecard ConfigurationWizard.

Note: If the installation wizard does not start automatically, run the file: <DVD_
ROOT>\Windows_Setup\HPXS_9.4_setup.exe

 If you copy the installation directory from the DVD or from HPLN, make sure that the
path to the target directory does not include blank spaces.

Installation Section of the Wizard

Follow the prompts until you get to theSelect Group page.

1. On theSelect Group page, select HP Executive Scorecard - Distributed Installation, and
then click Next.
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2. On theSelect Features page, select the component you are installing on this server, and then
click Next.

Common Components are automatically selected and installed with each component.

3. On theChoose the folders page, click Next to accept the default application folder, or
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Browse to navigate to and then select a new application folder location.

Note: If you enter a new application folder name, it cannot contain embedded spaces. For
example a folder with a nameHP XS is invalid.

The wizard then runs a series of checks to validate system requirements.

If an installation check failed, youmight be required to perform corrective action before you can
run the installer. Certain checks can be corrected after a component has been installed.

4. On the Install Checks page, ensure that all the installation checks are successful, and click
Next.
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5. On thePre-Install Summary page, verify that the components you wish to install are listed,
and then click Install.

The file copying process starts. On completion, the ConfigurationWizard begins.

Post-Install Wizard

Note: Make sure that you installed DWH and BOE on a another server before you installed
XS on this server.

1. On theManagement Database - Configure Management Database Settings page,
Connect to an existing one, and then click Next.

2. On theManagement Database - Configure Management Database Connectivity Settings
page, enter the following, and then click Next.
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UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting theManagement database.

Note:

If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.
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UI
Element Description

Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change this value
to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available from
the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).

Database
name

The name of theManagement database.

It is recommended that you use the following database naming convention:
databasename_mng

Tip: Make note of the database name, as it may be needed when installing other
components.

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database. The user must
have the administrator permissions.

Password The password for the specified user.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

3. On theManagement Database - Configuration Status page, verify that theManagement
database configuration was completed successfully, and then click Next.

4. In theManagement Database - Load a License page, check that a valid permanent license
was found, and click Next.
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The wizard recognizes the license entered in the previous version.

Post-Install Wizard - Application Configuration Section

1. On theApplication Configuration - Configure Web Server Infrastructure Connectivity
page, enter the following:
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Data related configuration area:

UI
Element Description

Time Zone The DataWarehouse time zone used when consolidating the data extracted from
the data sources.

Web Server Configuration area:
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UI
Element Description

HTTP
port

The port of the HTTP listener. The default port is 80. For more information about
ports, see the Support Matrix document available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the Installation DVD).

Note: If you want to use the default HTTP port in the Executive Scorecard
installation, youmust ensure that port 80 is not in use by another process.

HTTPS
port

The port of the HTTPS listener. The default port is 443. For more information about
ports, see the Support Matrix document available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the Installation DVD).

Business Objects enterprise area:

UI Element Description

SSO shared secret Enter the SSO shared secret.

Confirm SSO shared secret Confirmation of the SSO shared secret.

2. On theApplication Configuration - Configure Target Database Settings page, select
Connect to an existing database:
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UI Element Description

Create a new database Select to create a new target database.
Connect to an existing database Select to connect to an existing target database.

3. On theApplication Configuration - Configure Target Database Connectivity Settings
page, enter the following:
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UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQL server
hosting the target database.

Note:

If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.
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UI
Element Description

Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change this value
to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available from
the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).

Database
name

The name of the target database.

It is recommended that you use the following database naming convention:

databasename_trg

SQL Server authentication area:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database. The user must
have the administrator permissions.

Password The password for the specified login that creates the Target database.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

4. On theExecutive Scorecard- Configure Executive Scorecard database page, select
Connect to an existing database:
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5. On theExecutive Scorecard - Executive Scorecard MS SQL Settings page, enter the
following, and then click Next.
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UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting theManagement database.

This is themanagement DB created on the DWH component

Note:

If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.

HP IT Executive Scorecard (9.40)Page 88 of 100

UpgradeGuide
Upgrade to 9.4 in a Distributed Environment



UI
Element Description

Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change this value
to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available from
the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).

Database
name

The name of theManagement database.

It is recommended that you use the following database naming convention:
databasename_mng

Tip: Make note of the database name, as it may be needed when installing other
components.

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database. The user must
have the administrator permissions.

Password The password for the specified user.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingly.

6. ghjhkjhk

6.

7. On theExecutive Scorecard - Executive Scorecard Summary page, check that the
operation completed successfully and click Next.
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8. Configure and upgrade Financial Planning and Analysis:

a. On the Financial Planning and Analysis - Installing FPA page, click Next to install the
Financial Planning and Analysis module.

b. On the Financial Planning and Analysis - Summary page, check that the operation
completed successfully and click Next.

9. On theSummary page, check that the operation completed successfully and click Next.

You can now proceed with "Additional Steps" on the facing page.
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Additional Steps
This section explains additional steps for the 9.40 upgrade.

To understand what is new in version 9.40, seeWhat's New in Version 9.40 in the IT Executive
Scorecard Release Notes.

The upgrade procedure uses the following addsteps:

"Integrating with HP ServiceManager" on the next page

"Integrating with HP Asset Manager and ServiceManager" on the next page

"Disaster Recovery" on the next page

"Optional, WhenWorkingWith a Non-English Language" on the next page

"Display theWebi and the Xcelsius Reports" on page 96

"Upgrade the 9.31 Content Acceleration Packs (CAPs)" on page 96

Reactivate the Data Sources
1. Reactivate the data sources. After completing the upgrade, all connected data sources will

be in theDeactivated state. Youmust reactivate the desired data sources using the Executive
Scorecard user interface. For more information, see Data SourceManagement in the
Administrator Guide.

Note:When reactivating BSM andUCMDB after upgrade procedure, youmay have to re-
enter the UCMDB username and password. For details, see Data SourceManagement in
theAdministrator Guide.

2. If the NNM Content Pack was activated in 9.31. If the NNMContent Pack was activated in
9.31, and if HP Network NodeManager does not need a password to connect to the shared
folder (for example when the shared folder resides on the local machine), youmust edit the
setting of the connection and delete the password value, before you activate the NNMContent
Pack. To do that proceed as follows:

a. In the application, click Admin > Data Source Management.

b. Click theEdit Settings link for HP Network NodeManager.

c. Delete the values in thePassword field, and perform any additional changes.

d. Click Next twice.

e. After the data source is successfully configured, click Close.
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Integrating with HP Service Manager
If you are integrating with HP ServiceManager, note that the source column used to populate
CFGITEM_DIM was modified in 9.31 to obtain better results. As a consequence, after upgrading to
9.31, reactivate the SM Content Pack. Before running the ETL, run the XS batch command dw_
abc_cleandata.bat -batch 1 -entity CFGITEM and go toAdmin > ETL Management to start the
clean data stream in order to delete the existing CFGITEM_DIM data. This updates the data for the
next run of the ETL.

Integrating with HP Asset Manager and Service
Manager

Before running the ETL, run the command dw_abc_cleandata.bat –batch [Batch Id] – entity
ASSET and go to Admin Tab > ETLManagement UI to start the clean data stream in order to delete
the existing ASSET relevant data . This updates ASSET data for the next run of the ETL.

Disaster Recovery
In case of disaster, find the latest disaster recovery procedure in the 9.4Administrator Guide
available from theManuals site at HP Software Product Manual Site
(http://h20230.www2.hp.com/selfsolve/manuals).

Optional, When Working With a Non-English
Language

If you are working with a non-English language proceed as follows:

1. Localize the KPI Library
The localized installation adds the language libraries of XML files in specific folders. You copy
and then import these files to display the out-of-the-box template Scorecards, Perspectives,
Objectives, Folders, and KPIs in the KPI Library in the selected language.

To localize the out-of-the box content of the KPI Library: Scorecards, Perspectives,
Objectives, and KPIs, proceed as follows:

a. In the Executive Scorecard server, locate the
<XS_installation_directory>\agora\glassfish\glassfish\domains\BTOA\config\
kpitemplates\import\languages\<language_code>_<country_code> folder relevant for
the language you want to use in the application. The .xml files in the folder represent both
KPIs and KPI directories.

The language code and country codes are as follows:
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Language Language Code Country Code

Brazilian Portuguese pt BR

French fr FR

Spanish es ES

German de DE

Japanese ja JP

English en US

Dutch nl NL

Italian it IT

Simplified Chinese zh CN

Korean ko KR

Russian ru RU

Turkish tr TR

b. Copy these .xml files to the <XS_
server>\agora\glassfish\glassfish\domains\BTOA\config\kpitemplates\import\load
folder.

Tip:

If the folder contains other sets of files (for different languages), it is recommended to
keep in the folder only the required set of language files and tomove the other files
outside the folder to prevent the loading of both set of language files and an unknown
result.

c. Import the out-of-the-box language files using theKPILoader > importKPIs() procedure
described in "Import or Export Trees and KPIs"in theAdministrator Guide.

2. Localize the Dashboard Pages and Components
The localized installation adds the language libraries of XML files in specific folders. You copy
and then import these files to display the out-of-the-box template pages and components in the
selected language, in the Dashboard.

During the upgrade to 9.40, all OOTB Page and Component categories in English and other
languages are deleted and only the 9.40 Pages and Component categories in English are
recreated. They include the OOTB pages and components for 9.40. If in the previous version
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you had created pages and components and had assigned them to OOTB Page or Component
categories, you have to reassign themmanually.

To localize the out-of-the box pages and components, proceed as follows:

a. In the Executive Scorecard server, locate the
<XS_installation_
directory>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\
import\languages\Components\<lang>_<country_code>\<name>.uim.xml or <XS
server>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\
import\languages\Pages\<lang>_<country_code>\<name>.uim.xml files relevant to
the language you want to install. These .uim.xml files represent the components and the
pages used in the Dashboard. lang is the language code and country_code is the code of
the country:

Language Language Code Country Code

Brazilian Portuguese pt BR

French fr FR

Spanish es ES

German de DE

Japanese ja JP

English en US

Dutch nl NL

Italian it IT

Simplified Chinese zh CN

Korean ko KR

Russian ru RU

Turkish tr TR

b. Copy these .xml files to the
<XS_installation_
directory>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\import\toloa
d folder.
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Tip:

If the folder contains other sets of files (for different languages), it is recommended to
keep in the folder only the required set of language files and tomove the other files
outside the folder to prevent the loading of both set of language files and an unknown
result.

c. Import the out-of-the-box language files (only for the pages and components - events
are not localized) using the relevant procedure described in "Import or Export Out-of-the-
box Pages, Components, and Events" in theAdministrator Guide.

3. Test the installation
Check the universes in the Executive Scorecard Studio:

a. If you do not see them, run the Loadmeta data JMX.

b. If you still cannot see the universes, restart SAP BusinessObjects Enterprise and rerun the
“Loadmeta data” JMX. For details, see the IT Executive Scorecard Troubleshooting Guide.

4. Set up the User Interface Display Language
All translated files are provided with the product and the language of the user interface depends
on the language settings of your browser. English is the default language.

a. If you want to display the user interface in a non-English language, go to your browser
Tools > Internet Options.

b. In theGeneral tab, click Languages.

c. Add the language you want to view in the user interface and useMove up to move it to be
the first in the list.

d. Open a new browser and login to Executive Scorecard. The application is presented in the
chosen local language.

5. Set up the Input and Content Language
The inputs and content language (i18N) depends on the definitions of your database. For
details on the supported languages, see IT Executive Scorecard Support Matrix.

6. Import localized CAPs.

To upload localized CAPs:

a. Delete the pre-imported out-of-the-box CAPs in the English language.

b. Upload the localized CAPS:
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o Localized out-of-the-box CAP. To upload a localized out-of-the-box CAP, proceed as
described in "Additional Steps" on page 91 and specify the location of the out-of-the-box
CAP.

Note: Localized out-of-the-box CAPs .ZIP files are placed in the relevant language
folder during installation:
..\HPXS\agora\glassfish\glassfish\domains\BTOA\config\cap\import\langua
ges

For example, the VPOPS CAP in German is located at:
..\HPXS\agora\glassfish\glassfish\domains\btoa\config\cap\import\language
s\de_DE\VPOPS_de_DE.zip

o Localized user-defined CAP. To upload a localized user-defined CAP proceed as
described in "Additional Steps" on page 91 and specify the location of the localized
CAP you have created.

Display the Webi and the Xcelsius Reports
When Executive Scorecard is installed on an SQL Server named instance, and in order for the
Xcelsius andWebi reports to display properly in the relevant Dashboard components, the relevant
universe (Context) connectionmust be updated to point to the <sql server name>\<named
instance>.

To point to the named instance use the following steps:

1. Open the SAP BusinessObjects Enterprise Designer application on the SAP BusinessObjects
Enterprise server.

2. Click Tools > Connections to display the connection list.

3. Select XS_DWH_JDBC and click Edit.

4. In theServer field enter <sql server name>\<named instance>:1433.

5. Click Next and then Finish.

6. Click File > Export, and then click OK.

7. Run a report to see if it works

Upgrade the 9.31 Content Acceleration Packs
(CAPs)

OOTB CAPs
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If you worked with Content Acceleration Packs (CAPs) in version 9.31, youmust upgrade the
CAPs so they work in 9.4.

Copy the CAP kpi files from load folder: <XS_
server>agora\glassfish\glassfish\domains\BTOA\config\cap\import\load\ to the loaded folder:
<XS_server>agora\glassfish\glassfish\domains\BTOA\config\cap\import\loaded\.

User-Defined CAPs

To upgrade existing User-Defined CAPs:

1. Activate the version 9.31 CAPs.

2. Upgrade Executive Scorecard to version 9.4.

3. Create a new CAP based on the entities of the 9.31 CAP that you activated.

4. De-activate the original CAP.

5. Delete the original CAP.

6. Activate the new CAP.

For details on all CAP procedures, see Content Acceleration Pack in theAdministrator Guide.

l a.

Item in the 9.30
manifest.properties
file

Item in the 9.31
manifest.properties file Do the following:

UUID=< A unique ID for
the Content Acceleration
Pack>

universe= <The
names of the
universes
to be calculated
(comma separated).
For example,
Period_Universe.>

BCs= <The names of the
universes
to be calculated (comma
separated). For example,
Period_Universe.>

This information stays the same.

This information stays the same.

version= <The
version of the
Content
Acceleration Pack>

version= <The version of
the Content Acceleration
Pack>

This information stays the same.
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Item in the 9.30
manifest.properties
file

Item in the 9.31
manifest.properties file Do the following:

xs.version= <The version
of Executive Scorecard>

Add the version of Executive
Scorecard that was used when you
created the CAP. The version
number is available in theAbout
dialog in the top right corner of the
application.

name= <The name of the
Content Acceleration
Pack. Mandatory>

Enter a name for the CAP.

description= <The
description of the Content
Acceleration Pack.>

You can add a description for the
CAP.

publisher= <The name of
the user, partner, or
company that created the
CAP.>

You can optionally add the name of
the publisher.

documentation= <The
path to the file that
documents the CAP. The
document can be in
Microsoft WORD, or
PDF format.>
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We appreciate your feedback!
If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:

Feedback on IT Executive Scorecard, 9.40 Upgrade Guide

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client,
and send your feedback to SW-Doc@hp.com.
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